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[bookmark: _Toc221090717]Introduction to SPDiag
The SharePoint Diagnostic tool (SPDiag) version 1.0, included with the latest release of the SharePoint Administration Toolkit, was created to simplify and standardize troubleshooting of SharePoint Products and Technologies, and to provide a unified view of collected data. SharePoint Products and Technologies administrators can use SPDiag to gather relevant information from a farm, display the results in a meaningful way, identify performance issues, and export the collected data and reports for analysis by Microsoft support personnel.
The SharePoint Products and Technologies platform is highly complex and can be used for a wide variety of uses. Deploying, managing, and troubleshooting SharePoint Products and Technologies requires extensive knowledge spanning multiple technology areas, including security, networking, such Web technologies as ASPX, and SQL Server.
Traditionally, SharePoint Server troubleshooting involves manually collecting a wide array of data from servers in the affected farm, and then manually analyzing the data to determine the source of the problem. This process can be complex and time-consuming, and data collection itself can place a significant load on the servers.
SPDiag is designed to collect and review data from SharePoint Products and Technologies Web servers, application servers, and SQL servers, and store the collected data for each project in a SQL Server database for retrieval and analysis. SPDiag can collect performance data from IIS logs, ULS logs, and performance counters, and can also collect live data from the servers using Windows Management Instrumentation (WMI). Data can then be displayed in the Trends pane of the SPDiag interface and filtered to reveal trends, bottlenecks, and other performance issues that would otherwise require significant manual data processing to uncover. You can also view the individual components and the logical structure of the farm in the Snapshot pane.
SPDiag operates in the context of a project, which is the container used to store collected data for a specific farm. Each project has its own database, and you can create many projects for a single farm, subject only to database server resource limitations. Projects can be saved and reopened again at a later time, and new data can be added to a project between SPDiag sessions. You cannot move data between projects, and you cannot collect data from more than one farm in a single project. Because all SPDiag project data is stored in a SQL Server database, you can back up a project database or move it to another database server.
SPDiag can be used in online or offline modes. In online mode, SPDiag is installed on a Web server belonging to the farm you want to troubleshoot. This allows SPDiag to connect to the farm and collect data. In offline mode, SPDiag is installed on a computer that is not a part of a farm. It can only be used to review existing SPDiag projects, and cannot collect data.
You can export collected data and reports as data files, which can then be sent to Microsoft support technicians for analysis. This can help to facilitate remote troubleshooting by ensuring that the required data is captured on-site, and by consolidating the data in a standardized format.
[bookmark: _Toc221090718]Setup and configuration
Read this section for information about SPDiag installation, configuration details, and how to configure farm servers for the troubleshooting process.
[bookmark: _Toc221090719]Installing SPDiag
SPDiag is installed with the latest version of the SharePoint Administration Toolkit (http://go.microsoft.com/fwlink/?LinkId=141504).
You can install SPDiag on any computer in the SharePoint farm. To ensure optimum performance, you should install SPDiag on the farm server with the least resource usage. For example, a dedicated Central Administration Web server would be an ideal host.
In order to collect performance counter data, you must install the .NET Framework 3.5 on the SPDiag host computer. To display performance counter data, you will also need to install the Microsoft Chart Controls for the .NET Framework 3.5.
To download the .NET Framework 3.5, see Microsoft .NET Framework 3.5 (http://go.microsoft.com/fwlink/?LinkId=141508).
To download the Microsoft Chart Controls, see Microsoft Chart Controls for Microsoft .NET Framework 3.5 (http://go.microsoft.com/fwlink/?LinkId=141512).
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\note.gif]Note: 

	SPDiag can be used in online or offline modes. In online mode, SPDiag is installed on a Web server belonging to the farm you want to troubleshoot. This allows SPDiag to connect to the farm and collect data. In offline mode, SPDiag is installed on a computer that is not a part of a farm. It can only be used to review existing SPDiag projects, and cannot collect data. 
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	Using SPDiag can consume significant resources, such as network bandwidth, on the database server used to host the project database. Make sure that both the project database server and the network between the project database server and the farm have adequate resources available for running SPDiag. 
SPDiag does not consume substantial resources on the host computer. 



The default SPDiag installation directory is C:\Program Files\Microsoft\SPAdministrationToolkit\SharePoint Diagnostics.
[bookmark: _Toc221090720]Configuring the tool
After you open a new SPDiag project, and before you begin collecting data with SPDiag, you should use the Options dialog box to configure the tool. In most cases, the default values will work, but if performance monitor file or IIS log file locations have been changed from their default locations on any of the servers in the farm, you can specify their locations here.
You can also specify a network share from which to collect log files if you have a log file archive on the network.
Files tab
On the Files tab, you can set the locations of data files that SPDiag uses to collect information. Note that for each server, you must specify the exact local path to the folders containing the log files. You can add multiple paths with each entry separated by a semicolon. SPDiag does not search recursively, so any subdirectories containing log files must be added explicitly.
· Select server: Use this field to select the Web server on which you wish to specify file locations.
· Performance counter file location: Use this field to set the path for the performance counter files on the Web server.
· IIS log file location: Use this field to set the path for the IIS log files on the server.
Misc tab
On the Misc tab, you can set various options for collected information. 
· Log upload speed: Use this field to specify the rate at which logs will be uploaded to the project database. There are three settings: Low, Medium, and High. Low collects data from one server at a time, Medium collects data from up to 5 servers simultaneously, and High collects data from up to 10 servers simultaneously. The default is Medium.

If you are using the farm’s database server to store the project database, you should use Low or Medium to reduce the performance impact on the database server. If you are using a dedicated computer to host the project SQL Server database, you can use High for maximum performance.

If you want to change the log upload speed after data collection has begun, you can click Cancel in the data collection notification window, change the log upload speed, and restart data collection.
· Max number of rows in custom reports: Use this field to specify the number of rows you wish to display in customer reports that you generate. The default is 100 rows.
· Max number of rows in merged logs: Use this field to specify the number of rows you wish to collect from all log files that are included in the project. The default is 50,000 rows.
· Performance counter time interval (in seconds): Use this field to specify the refresh rate of performance counters used for data collection. The default is 5 seconds.
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	This setting does not affect the refresh rate for data collected through Live Capture. See the "Collecting performance counter data using Live Capture" section later in this article for more information.


[bookmark: _Toc221090721]Configuring the farm servers
Before you begin using SPDiag, you must ensure that the servers in the farm are configured to provide the data required by SPDiag.
While most of the data needed for troubleshooting is logged by default on farm servers, there are certain data points that must be manually configured.
Configuring performance counters
Before you use SPDiag to collect data from farm servers, you can use the Performance Monitor snap-in (Perfmon.msc) to create a binary (.blg) PerfMon logs on your farm servers. SPDiag can collect data from any .blg files it finds in the performance counter file location you specified for each farm server.
When you are troubleshooting a SharePoint farm, it is helpful to log a wide spectrum of performance data, especially processor and memory usage, disk I/O, and important IIS counters. If possible, log any performance counters that might contain useful information on every farm server over a period of time sufficient to capture measurements that span both peak and off-peak farm usage.
You can also use SPDiag’s Live Capture feature to create data collector sets on farm servers. See "Collecting performance counter data using Live Capture" section later in this article for more information.
Configuring IIS logs
SPDiag collects information from the IIS logs on Web servers in the farm. IIS logs most of the required information by default, but SPDiag requires certain data that is not logged by default.
Use the information in this section to make sure that IIS is correctly configured.
The IIS logs should be checked to assure that logs are created in the W3C Extended Log Format (the IIS default), and that all the fields needed to create reports, as shown in the table below, are present in the logs. If the logs are in a non-W3C format, then you can use LogParser.exe to manually convert the logs to the W3C format.
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	SPDiag assumes that IIS log files are collected in UTC time, while all other logs represent local server time. If you have to convert your logs to W3C, IIS logs are imported into LogParser in UTC. Therefore, before collecting converted IIS logs with SPDiag, you should convert all time records in the log files to UTC. 



The following table displays the IIS log fields that are commonly used for troubleshooting, and indicates whether they are logged by default and whether they are required for SPDiag troubleshooting. Before you collect data with SPDiag, it is recommended that you enable any fields in this table that are not being logged on the Web servers in your farm. If you elect to enable a field for logging, you should enable it on all Web servers in the farm.
	Field
	Appears as
	Description
	Logged by default?
	Required?

	Time taken
	time-taken
	The length of time that the action took, in milliseconds. 
Note that this is a required field for SPDiag troubleshooting, and is not enabled by default.
	N
	Y

	Host
	cs-host
	The host header name, if any.
Note that this is a required field for SPDiag troubleshooting, and is not enabled by default.
	N
	Y

	Date
	date
	The date on which the activity occurred.
	Y
	Y

	Time
	time
	The time, in coordinated universal time (UTC), at which the activity occurred.
	Y
	Y

	Client IP address
	c-ip
	The IP address of the client that made the request.
	Y
	Y

	Method
	cs-method
	The requested action, for example, a GET method.
	Y
	Y

	URI stem
	cs-uri-stem
	The target of the action, for example, default.htm.
	Y
	Y

	URI query
	cs-uri-query
	The query, if any, that the client was trying to perform. A Universal Resource Identifier (URI) query is only necessary for dynamic pages. 
	Y
	Y

	HTTP status
	sc-status
	The HTTP status code.
	Y
	Y

	User agent
	cs(User-Agent)
	The browser type or other client from which the request originated.
	Y
	Y

	User name
	cs-username
	The name of the authenticated user who accessed your server. Anonymous users are indicated by a hyphen.
	Y
	N

	Server IP address
	s-ip
	The IP address of the server on which the log file entry was generated.
	Y
	N

	Server port
	s-port
	The server port number that is configured for the service.
	Y
	N

	Protocol substatus
	sc-substatus
	The substatus error code.
	Y
	N

	Service Name and Instance Number
	s-sitename
	The Internet service name and instance number that was running on the client.
	N
	N

	Server name
	s-computername
	The name of the server on which the log file entry was generated. 
	N
	N

	Win32 status
	sc-win32-status
	The Windows status code.
	N
	N

	Bytes sent
	sc-bytes
	The number of bytes sent by the server.
	N
	N

	Bytes received
	cs-bytes
	The number of bytes received by the server.
	N
	N

	Protocol version
	cs-version
	The protocol version—HTTP or FTP—that the client used. 
	N
	N

	Cookie
	cs(Cookie)
	The content of the cookie sent or received, if any.
	N
	N

	Referrer
	cs(Referrer)
	The site that the user last visited. This site provided a link to the requested site.
	N
	N



If the IIS logs are missing required fields, you can manually configure IIS to add the fields. If you choose not to add the required fields, some reports will not be complete. A red circle with an exclamation point will appear at the top of the Consolidated Logs View pane if the collected logs are incomplete. You can check the SPDiag trace log in the SPDiag installation folder (by default, C:\Program Files\Microsoft\SPAdministrationToolkit\SharePoint Diagnostics\SPDiag.log) for more information.
Configuring the SQL Server project database
SPDiag uses a SQL Server 2005 or SQL Server 2008 database as a repository for collected data. Although you can use the same SQL Server database used by the SharePoint farm, we recommend you do so only if you are certain the server has sufficient resources, or you are using SPDiag during off-peak hours.
Each logical project has a single project database that can contain up to seven days of data. In large farm environments, this can represent a large volume of data, and the collection and retrieval processes can take hours and consume significant resources on the project database and on the network between the SPDiag tool and the project database server. For this reason, you should employ a separate database server for use as an SPDiag project data repository, unless the farm’s database server has the capacity to handle the extra load without causing performance issues for farm users.
The SPDiag user must have create permissions on the project database server instance. When a new project is created in SPDiag, a new project database is automatically created on the database server in the context of the user’s domain account. 
If you are planning to create SPDiag project databases on a database server in a different domain than your user account, or if Active Directory is not used in your environment, ensure that your account has the appropriate privileges to authenticate to the SQL Server database.
To download a trial version of SQL Server 2005, see Download SQL Server 2005 Trial Software (http://go.microsoft.com/fwlink/?LinkId=141485).
[bookmark: _Toc221090722]Using SPDiag
SPDiag is a tool used to collect, filter, and display data from a SharePoint farm for troubleshooting purposes. SPDiag is a read-only tool, and cannot make any changes to a farm. You can use SPDiag to help you to identify problems yourself, or as a way to collect the data needed by support personnel to help troubleshoot your farm.
The information in this section will help you understand how to create projects, filter, and collect data; generate graphs and reports; and export data to a file.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\Important.gif]Important: 

	The user running SPDiag must have Windows server administrator rights on all servers in the farm, as well as SharePoint farm administrator rights. These are the same permissions required to perform administrative tasks, such as running Stsadm commands. We recommend using an existing administrator account rather than creating a new one. Running SPDiag with insufficient permissions might result in incomplete data collection, as well as slow performance. 



Using SPDiag to troubleshoot a farm involves the following general steps:
1. Creating a new project.
2. Ensuring that log files and performance counter files are available for each farm server, and noting log file locations for each farm server. 
3. Selecting a date/time range for the data you want to analyze.
4. Selecting the performance counters and log files for analysis.
5. Collecting data from the farm servers.
6. Displaying data in performance counter graphs and custom reports.
7. Exporting data to be analyzed by consultants or support personnel.
[bookmark: _Toc221090723]Creating a new project
An SPDiag project consists of a collection of data representing up to seven consecutive days of IIS, ULS and event logs, and performance counter log data. A project is stored in a SQL Server database on a database server that you specify. A project can be saved indefinitely, and data in the project can be reused many times to create snapshots and reports based on different sets of data stored in the project database. 
To create a new project in SPDiag, use the following procedure.
Create a new project
1. On the File menu, click New Project.
2. In the New Project dialog box, in the Database Server field, type the name of the database server on which you want to store the project in the format <servername\database instance>.
3. In the Project Name field, type a name for the project. The name will be used as the database name. The project name can only contain alphanumeric characters and underscores.
4. In the Project Description field, you can optionally enter descriptive text about the project.
5. Click Create to create the project database.
6. A message displays the following text, "Creating project, this may take a few minutes". Click OK.
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	When you create a new project, if you have not properly configured the IIS logs on the farm Web servers, you might receive a warning message reading "The following servers have missing IIS log fields that may result in incomplete SPDiag reports: <server name(s)>". If you see this warning message, note the names of the servers listed in the message and see the "Configuring IIS logs" section earlier in this document for information on how to correct the problem. 


[bookmark: _Toc221090724]Working with data
SPDiag collects several different kinds of data, and amalgamates collected data in displays and reports. There are two primary views in SPDiag: Snapshot and Trends.
The Snapshot view is displayed by default when you open SPDiag. Snapshot data, which contains information about the logical structure of the farm as well as details about the hardware and software in the farm, is collected by updating the Snapshot pane. Snapshot data is static once it has been collected by SPDiag, and is not used in reports or graphs in the Trends pane.
[image: ]
Figure 1: The Snapshot pane
In Trends view, SPDiag provides filters that allow you to select specific data points from log files and performance counter output data that has been captured on servers in the farm. This data is useful when you want to correlate data from a specific time range in the past with observed performance issues.
[image: ]
Figure 2: The Trends pane
You can also use Live Capture to collect data in real time by creating and running a data collector set on a target server in the farm. This is useful when you want to observe the results of real time events on farm performance. For example, you could start a Live Capture session and then manually start a backup job on the farm to observe the results. See the "Collecting performance counter data using Live Capture" section later in this article for more information.
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	Before you begin selecting data for collection, you should carefully consider what data points are needed to troubleshoot effectively, and avoid collecting data that is not useful. 



SPDiag uses a SQL Server database as the repository for collected data. Each logical project is stored in a single database that can contain up to seven days of data. SPDiag can collect performance data from IIS logs and performance counters on the farm servers, and can also collect live data from the servers using data collector sets you configure in Live Capture.
All captured performance counters, logs, and report data points are retrieved from the project database as needed. Once you select a specific data point to be displayed for a certain timeframe, that data is stored in the project database and will not be collected from the farm servers again.
If you wish to discard stored data, you can purge the project database by clicking Purge Data on the Data menu. By selecting the date range for data you wish to purge, all data for the date range will be removed from the project database. Data that is stored on the farm servers, such as .blg files created by data collector sets, will not be removed from the farm servers when you purge data in SPDiag.
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	Data collection, which takes place every time you set filter parameters, might take a long time, and might significantly impact farm performance, depending on server resource availability and the volume of data being collected. In a large farm environment, or an environment in which network bandwidth or other resources are limited, data collection could take several hours. 
When you begin using SPDiag, we recommend that you initially collect data for a short time period so you can evaluate the performance impact of data collection on the farm servers. You can then modify the upload speed setting on the Options menu as needed. 



Read the sections below for details on how to filter, collect, display, and export data.
Snapshot view
SPDiag collects information about the hardware, software, and logical structure of the connected farm and displays it in the Snapshot pane. 
You can export the snapshot to an XML file that can be saved as a record of your farm configuration and topology, and can supplement other troubleshooting documentation and maintenance records.
To update the information in the Snapshot pane, right-click an object in the tree view pane and then click Update. All objects under the selected object will then be updated to reflect their current values.
Selecting and collecting data in Trends view
Once you have collected data from the farm, the data points that have been collected are rendered in their respective panes in the Trends tab. You can also select data from the collected log files and performance counters for inclusion in a custom report in the Custom Reports pane. You can also display collected performance counter data in the Performance Monitor pane.
The Consolidated Logs View pane displays the contents of all collected IIS, ULS, and event log files by object. You can use the bottom scroll bar to read the raw log entries in this pane.
The Performance Monitor pane displays performance counter data that you select in a graphical format. You select the data to display by setting a filter that extracts data from the collected performance counter files.
The Custom Reports pane allows you to view reports that list the top sites, slow requests, and failed requests from the collected data. You can filter this data in a variety of useful ways.
Data selection and collection for trend analysis is done in the Trends pane, which you access by clicking the Trends tab in the main SPDiag window.
The master filter bar at the top of the Trends pane governs the time frame and scope (the Web servers and Web applications) of the data that is displayed in all three sections of the Trends view. You use the fields in the master filter bar to specify the time frame and scope for collecting data, and for displaying data that has already been uploaded into the project database. After you make changes to the time frame or scope, click the Refresh button to update the data displayed in the Trends view.
First, on the master filter bar, select the time frame, the servers, and the Web applications from which you want to collect data.
[image: ]
Figure 3: The master filter bar
Select time frame and collection scope
1. In SPDiag, click the Trends tab.
2. In the Analyzing drop-down calendar control, select the date from which to start collecting data.
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	The first time you select a date in an SPDiag project, you can choose any date in the past. This sets the project’s date range of seven consecutive days, beginning at the first date you chose. Once this date range has been set, any date outside the date range will be grayed out in the Analyzing calendar control. If you want to analyze data from another time period, you must create a new SPDiag project. 

	


3. In the From control, select the local server time at which to start collecting data.
4. In the To control, select the local server time at which to stop collecting data.
5. Click the SharePoint Scope button to select the servers and Web applications from which to collect data.
In the Select servers and Web applications dialog box, all servers and Web applications in the farm are listed. All servers and Web applications are selected by default. Use the check boxes next to each server and Web application to select the ones from which you want to collect data.
Next, select log file data you want to collect for the time frame and scope you specified in the last procedure.
[image: ]
Figure 4: The Merged Logs Filter
Select and collect log file data
1. In the Consolidated log view pane, click the Filter Logs button.
2. In the Merged Logs Filter dialog box, you can select IIS logs, ULS logs, and event logs. When you select any of the three options, SPDiag will collect those logs inclusively for the time frame and scope you specified.
3. You can exclude records from collection by defining a filter under each log type. In the Hide entries based on this filter section under a given log type, use the And/Or field to specify whether a filter statement is in addition to or in exclusion of the prior filter statements, the Field name field to select the record you wish to add to the filter, the Operator field to set statement operators (such as greater than, equals or contains), and use the Value field to specify the value to use in the filter statement.
It is important to remember that the merged logs filter is exclusionary, and that any records you select in a filter will be excluded from data collection.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\note.gif]Note: 

	You can use filters to explicitly display selected data by using negative operators. For example, if you have selected IIS to collect IIS logs, you can collect only records specific to the client IP address 192.168.0.32 by setting the following filter: 
· Field name: Client IP address
· Operator: Not Equal
· Value: 192.168.0.32

The use of the Not Equal operator will exclude from collection all records in which the client IP address does not equal the specified value. You can add other OR statements with negative operators to the filter to explicitly view other records. 

	


4. Click Ok to collect the data you have selected and close the Merged Logs Filter dialog box. You can also click Apply if you want to collect the log file data and leave the Merged Logs Filter dialog box open.
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	If you click Apply to collect the selected data and then click Ok, the data will be collected from the farm servers again. If you want to close the Merged Logs Filter dialog box without refreshing the data, click Cancel. 
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	In some cases, a Perfmon .blg file might take a long time to upload to the project database. This can happen when the .blg file contains a large number of performance counters or a large amount of data. If it is taking too long to upload a .blg file, you can use Relog.exe, a built-in Windows Server tool, to resample the log file and create a new log file based on only specific counters, a certain time period, or a longer sampling interval. 
For example, you could use the following command to create a new log file that contains only the data for total processor time: 
relog logfile.blg -c "\Processor(_Total)\% Processor Time" -o newlogfile.blg 
If you use Relog.exe to create a smaller .blg file on a farm server, you should move the original .blg file to a folder that is not read by SPDiag. You can see the folder that SPDiag uses to access farm server performance counter data for each farm server on the Files tab, accessible by choosing Tools and then Options. 
For more information on using Relog.exe, see Two Minute Drill: RELOG.EXE (http://go.microsoft.com/fwlink/?LinkId=141333). 



Next, select performance counter data for the time frame and scope you specified.
[image: ]
Figure 5: The Performance Counter Filter, server selected
Select and collect performance counter data
1. In the Performance Monitor pane, click the Filter Counter button.
2. In the Performance Counter dialog box, select a value from the Servers drop-down menu. You can select a server name from the menu to display specific performance counters from that farm server. You can also select Farm, which displays calculated farm-wide measurements based on IIS log data.
a. If you selected a server from the Servers drop-down menu, a list of expandable performance counter categories will appear in the field below. Expand a category and select a performance counter from the list of available queries by clicking it.
b. If you selected Farm from the Servers drop-down menu, an expandable tree entitled SharePointRequests will appear in the field below. Expand the parent item and select a query from the list of available queries by clicking it.
[image: ]
Figure 6: The Performance Counter Filter, Farms selected
3. Selecting a query will open its available instances in the Instances of selected object pane on the right side of the dialog box. Click the instance you want to select.
a. If you selected a server from the Servers drop-down menu, selecting a performance counter will display its available instances, which might be different for each counter. If no instances appear in the Instances of selected object pane, the main performance counter object will be used.
b. If you selected Farm from the Servers drop-down menu, the instances _Total and _Master-Filter will be displayed for each query you select. Selecting the _Total instance will collect this data from all farm servers, and _Master-Filter will collect data only from the servers that are currently enabled in the SharePoint Scope on the master filter bar.
4. You can also select a color for the displayed data, and the scale for the display, and then click Add. The selected performance counter instance will appear in the Performance Monitor pane.
Repeat this step for each performance monitor counter you wish to add to the display.
5. When you have selected and added all the performance counter instances you want to collect, click Ok to collect the data from the farm.
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	If any of the data you selected has already been collected, SPDiag will display the collected data rather than collecting it again from the farm. 



You can modify the performance counter display by hiding counters. In the list of displayed counters, clear the check box in the Show column for the counter you want to hide. Select the check box to add the counter to the display again.
You can also remove the counter from the display permanently by clicking the Remove button for the specific counter.
Creating a custom report from collected data
The Custom Reports pane allows you to generate three different kinds of reports based on the data that has been collected through the filters in the Consolidated Logs pane and the Performance Monitor pane. You can create the following types of custom report:
· Top Sites report, which lists the most accessed sites in the farm for the time period for which data has been collected.
· Slow requests report, which lists the requests with the longest response times.
· Failed requests report, which lists all requests that were not responded to by the farm.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\note.gif]Note: 

	The Custom Reports filter allows you to select from previously collected data in the project database. It does not collect new data from the farm servers. You must collect log data using the filter in the Consolidated Logs View pane before you can generate a custom report. 



You can filter data for your report by using the Custom Reports Filter. The filter parameters are persistent between uses of the Custom Report Filter dialog box within an SPDiag project, so when you close a project in SPDiag and then reopen it, the filter parameters you had previously defined will appear when you open the filter again.
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Figure 7: The Custom Reports Filter
Filter data for a custom report
1. In the Trends view, in the Custom Reports pane, click the Filter Reports button.
2. In the Custom Reports Filter dialog box, select the type of report you want to create from the Report Type drop-down menu.
3. If you want to create the report using all available data, click Ok to view the report and close the Custom Reports Filter dialog box, or click Apply to view the report without closing the Custom Reports Filter dialog box.
4. You can exclude records from the report by setting filter parameters. In the Hide entries based on this filter section, use the And/Or field to specify whether a filter statement is in addition to or in exclusion of the prior filter statements, the Field name field to select the record you wish to add to the filter, the Operator field to set statement operators (such as greater than, equals or contains), and use the Value field to specify the value to use in the filter statement.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\Tip.gif]Tip: 

	To remove a parameter from the filter, right-click anywhere in the row and click Delete. 

	


5. It is important to remember that, like the Merged Logs filter, the Custom Reports filter is exclusionary, and any records you select in a filter will be excluded from the report.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\note.gif]Note: 

	You can use filters to explicitly select data by using negative operators. For example, if you have selected the Host field in the Field Name column, you can collect only records specific to the host SERVER1 by setting the following filter: 
· Field name: Host
· Operator: Not Equal
· Value: SERVER1
The use of the Not Equal operator will exclude from the report all records in which the host name does not equal the specified value. You can add other OR statements with negative operators to the filter to explicitly view other records. 

	


6. Click Ok to create the report and close the Custom Reports Filter dialog box. You can also click Apply if you want to create the report and leave the Custom Reports Filter dialog box open.
You can now view the report in the Custom Report pane.
Collecting performance counter data by using Live Capture
In addition to collecting data from logs and performance counter files, SPDiag can also capture on-demand performance counter information by using Live Capture. The SPDiag Live Capture feature allows you to create a data collector set on the target server to record real-time performance counter data.
After the data collector set you created has been run on the target server, you can use the filter in the Performance Monitor pane to select and collect data from the data collector set. The Live Capture feature does not collect any data itself, but only allows you to create a collector set to generate a data file on the target server.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\note.gif]Note: 

	Only one data collector set at a time can be created on a single server. 



[image: ]
Figure 8: The Live Capture Filter
To collect data using Live Capture, follow the procedure below.
Create a data collector set using Live Capture
1. On the Data menu, click Live Capture.
2. In the Live Capture dialog box, in the Servers drop-down menu, select the farm server from which you want to capture data.
3. Once you have selected a server, a list of available performance counters appears in the field below. Select a counter that you want to capture, and click the Add button.
Note that some counters have multiple instances, which will appear in the Instances of selected object field when the counter is selected. In this case, select the desired instance from that list and click the Add button. Repeat this process for each instance you want to add.
4. After you have added all the performance counter instances you want to capture, in the Capture Options section, set the Sample Interval to the number of seconds between samples. The default is five seconds.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\Caution.gif]Caution: 

	If you select a smaller sample interval, a larger volume of data will be collected for the time frame you specified, and will take longer to collect. 

	


5. In the Capture counters between section, use the top row of date and time fields to set the start time and date for the Live Capture, and the bottom row of date and time fields for the end time and date. These settings represent the local dates and times on the server.
6. If you want to overwrite a Live Capture that might be currently running on the target server, you can leave the Replace a currently running Live Capture on that server with this new definition check box selected.
7. Click Create to create and run the data collector set on the target server.
8. Click Close to close the Live Capture dialog box.
The data collector set you created will generate a .blg file that contains the output of the performance counters you specified. This data will then be available for collection through the Performance Monitor filter.
You can also manually start, stop, and delete the last collector set you created on a farm server. This is useful if, for example, you wish to stop and restart a running collector set. Note, however, that you cannot start an expired collector set. If you want to run a collector set with the same counters as an expired set, you must create a new collector set, or simply leave the Live Capture dialog box open if you want to consecutively run several instances of the same collector set.
Start, stop, or delete a collector set
1. On the Data menu, click Live Capture.
2. In the Collector Sets section at the bottom of the Live Capture dialog box, select the target server from the Servers drop-down menu.
3. To start the last collector set you created, click Start.
To stop the last collector set you created, click Stop.
To delete the last collector set you created, click Delete, then click Yes in the dialog box that appears.
4. Click Close to close the Live Capture dialog box.
	[image: C:\Users\kvice\AppData\Local\Temp\DxEditor\DduePreview\Default\0ef9b2b9-c270-4413-98ac-81276b13d285\local\note.gif]Note: 

	You cannot edit an existing data collector set in SPDiag. If you want to edit a collector set, you can do so on the server on which it was created. 



For more information about collector sets, see "Scenario 3: Create a Data Collector Set from Performance Monitor" in the TechNet article Performance and Reliability Monitoring Step-by-Step Guide for Windows Server 2008 (http://go.microsoft.com/fwlink/?LinkId=141339).
Exporting data
You can export data from SPDiag in the form of reports. The available reports are Snapshot, currently displayed graphs, currently displayed custom report, and currently displayed events and logs.
When you export a snapshot, you will be asked if you want to update the snapshot before exporting. If the snapshot data has not been recently updated, you can click Yes to automatically update the data before exporting.
Export a report
1. On the Data menu, click Export.
2. In the Export Reports dialog box, check the reports you want to export.
3. In the Location field, either click Select folder to browse, or type the path to the desired export folder.
4. Click Export to export the files.
If you are delivering the exported data to a third party, you can compress the file to reduce its size using a commercially available data compression application. Microsoft Customer Support can use these files to help you to identify issues with your SharePoint Server farm.
The following table displays the files that SPDiag exports.
	File name
	Description

	Snapshot.xml
	Snapshot data

	CounterGraph.bmp
	The graph rendered in the Performance Monitor pane

	SelectedCounterList.txt
	The list of counters used to render the graph

	CustomReport.txt
	The current report rendered in the Custom Report pane

	MergedLog.txt
	The contents of the Merged Log pane


[bookmark: _Toc221090725]Known issues
Read this section for information about known issues in SPDiag version 1.0.
[bookmark: _Toc221090726]Unhandled exception in SPDiag when Named Pipes SQL connection is used
When you create a new project in SPDiag, and you try to create the project database on a SQL Server computer that has been configured to use named pipes instead of TCP/IP, SPDiag experiences an unhandled exception. We recommend that you configure the SQL Server computer you are using to host the project database to use TCP/IP connections.
If you must use named pipes, you can work around this issue by adding the prefix np: to the pipe name in the format np:hostname.
[bookmark: _Toc221090727]Database column in custom reports reads “NOT AVAILABLE”
If SPDiag is run in offline mode, the database column in custom reports will read NOT AVAILABLE. This is by design. When SPDiag is not connected to a SharePoint farm, this information is unavailable. If this condition is unexpected, check to be sure the farm is operational.
[bookmark: _Toc221090728]Installed physical memory value in Snapshot is incorrect for virtualized SharePoint servers
When you examine the “Installed physical memory” field in the Snapshot pane for a SharePoint server running in a virtual machine, the value is incorrect. There is no workaround at this time.
[bookmark: _Toc221090729]Unicode characters in URLs are logged by IIS as question marks
When Unicode characters are used in SharePoint URLs, IIS logging will convert the characters to questions marks unless UTF-8 logging is enabled in IIS, and the relevant language packs are installed on the computer running SharePoint Products and Technologies.
For more information on UTF-8 logging in IIS, see Enabling UTF-8 Format for Non-English Languages and Security (http://go.microsoft.com/fwlink/?LinkId=141340).
For more information about installing Office SharePoint Server language packs, see Deploy language packs (Office SharePoint Server) (http://go.microsoft.com/fwlink/?LinkId=141342). For information about installing Windows SharePoint Services 3.0, see Deploy language packs (Windows SharePoint Services) (http://go.microsoft.com/fwlink/?LinkId=141341).
[bookmark: _Toc221090730]Farm calculated performance counters are not displayed
In order for SPDiag to calculate and display Farm performance counters (such as number of requests across the farm, or request response time), you must first upload the IIS logs for the desired time range by selecting them in the Consolidated Logs pane. If data from the IIS logs have not been uploaded to the project database, SPDiag cannot calculate the data, and no results will be displayed for these counters.
[bookmark: _Toc221090731]Data is missing for some or all of the farm servers
If an SPDiag project is missing data even though SPDiag has been configured correctly, the user account you are using to run SPDiag might not have sufficient permissions to access WMI data, or to copy log files from the target servers. Make sure the user account has administrative rights on all farm servers, and has been granted administrator rights in SharePoint Products and Technologies.


The information contained in this document represents the current view of Microsoft Corporation on the issues discussed as of the date of publication. Because Microsoft must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Microsoft, and Microsoft cannot guarantee the accuracy of any information presented after the date of publication.
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